
GETTING STARTED GUIDE

VERSION 1.4V2



Mari™ Getting Started Guide. Copyright © 2011 The Foundry Visionmongers Ltd. All Rights Reserved. Use of this Getting Started Guide and the 
Mari software is subject to an End User License Agreement (the "EULA"), the terms of which are incorporated herein by reference. This Getting 

Started Guide and the Mari software may be used or copied only in accordance with the terms of the EULA. This Getting Started Guide, the Mari 

software and all intellectual property rights relating thereto are and shall remain the sole property of The Foundry Visionmongers Ltd. ("The 
Foundry") and/or The Foundry's licensors.

The EULA can be read in the Mari User Guide Appendices.

The Foundry assumes no responsibility or liability for any errors or inaccuracies that may appear in this Getting Started Guide and this Getting 

Started Guide is subject to change without notice. The content of this Getting Started Guide is furnished for informational use only.

Except as permitted by the EULA, no part of this Getting Started Guide may be reproduced, stored in a retrieval system or transmitted, in any form 

or by any means, electronic, mechanical, recording or otherwise, without the prior written permission of The Foundry. To the extent that the EULA 

authorizes the making of copies of this Getting Started Guide, such copies shall be reproduced with all copyright, trademark and other proprietary 
rights notices included herein. The EULA expressly prohibits any action that could adversely affect the property rights of The Foundry and/or The 

Foundry's licensors, including, but not limited to, the removal of the following (or any other copyright, trademark or other proprietary rights notice 

included herein):

Mari™ software © 2011 The Foundry Visionmongers Ltd. All Rights Reserved. 

Mari™ is a trademark of The Foundry Visionmongers Ltd.

Weta™ Digital is a trademark of Weta Digital Ltd.

In addition to those names set forth on this page, the names of other actual companies and products mentioned in this Getting Started Guide 

(including, but not the to, those set forth below) may be the trademarks or service marks, or registered trademarks or service marks, of their 
respective owners in the United States and/or other countries. No association with any company or product is intended or inferred by the mention 

of its name in this Getting Started Guide.

Linux ® is a registered trademark of Linus Torvalds.

Windows ® is the registered trademark of Microsoft Corporation. 

Adobe ® and Photoshop ® are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 

countries.

Maya ® is a registered trademark of Autodesk, Inc., in the USA and other countries.

Mari software engineering: Jack Greasley, Kiyoyuki Nakagaki, Marcus Shoo, Kevin Atkinson, Tim Ebling, Jed Soane, Daniel Lond, Robert Fanner, 

Duncan Hopkins, Mark Final, Chris Bevan and Carl Rand

Product testing: Michael Zannetou, Mark Titchener, Robert Elphick and Antoni Kujawa
Writing and layout design: Jack Elder, Jon Hertzig, Eija Närvänen and Charles Quinn

Proof reading: Jack Elder and Eija Närvänen

Mari includes Disney technology licensed from Walt Disney Animation Studios.

The Foundry 

6th Floor, Communications Building,

48 Leicester Square, 
London 

WC2H 7LT

Rev: December 7, 2011
Mari 1.4v2The Foundry



Contents

PREFACE About this manual. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Contact customer support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

INSTALLATION AND 

LICENSING

Steps for running Mari . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

System requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Install Mari . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
On Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
On Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Launch Mari  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
On Linux  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
On Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

License Mari . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
About licenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Licensing Mari on a single machine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Obtain an activation key. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Install the license . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Licensing Mari over a network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Obtain floating licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Install floating licenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Further reading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

MARI MODEL 

REQUIREMENTS

Model Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

ABOUT THE TUTORIALS Download sample files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Tutorial format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Sandbox  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

TUTORIAL 1: SETTING UP 

A MARI PROJECT

About this lesson . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
What this lesson teaches you. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
What you should know before starting this lesson . . . . . . . . . . . . . . 18
Resources you need to complete this lesson . . . . . . . . . . . . . . . . . . . 18
How long should it take?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

About Mari projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Steps for creating Mari projects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Open a new project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19



 4
 

Specify project options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Load geometry  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Save your project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Where do you go from here?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

TUTORIAL 2: SETTING 

THE VIEW AND LIGHTING

About this lesson . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
What this lesson teaches you. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
What you should know before starting this lesson . . . . . . . . . . . . . . 23
Resources you need to complete this lesson . . . . . . . . . . . . . . . . . . . 23
How long should it take?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

About Mari view and lighting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Steps for setting the camera and lighting . . . . . . . . . . . . . . . . . . . . . 25

Open your project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Adjust the view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Adjust the lighting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Where do you go from here?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

TUTORIAL 3: PAINTING! About this lesson . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
What this lesson teaches you. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
What you should know before starting this lesson . . . . . . . . . . . . . . 33
Resources you need to complete this lesson . . . . . . . . . . . . . . . . . . . 33
How long should it take?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

About painting in Mari . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Steps for painting in Mari. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Open your project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Open the Colors and Shelf palettes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Select a color  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Select a brush . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Paint!. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Bake your painting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Where do you go from here?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

TUTORIAL 4: PAINTING 

THROUGH AND CLONE 

STAMPING

About this lesson . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
What this lesson teaches you. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
What you should know before starting this lesson . . . . . . . . . . . . . . 43
Resources you need to complete this lesson . . . . . . . . . . . . . . . . . . . 43
How long should it take?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

About painting from images in Mari. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Steps for painting through and clone stamping . . . . . . . . . . . . . . . . . 44

Open your project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Load an image. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Mari 1.4v2The Foundry



 5
 

Paint through . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Clone stamp  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Where do you go from here?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

TUTORIAL 5: EXPORTING 

AND IMPORTING

About this lesson . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
What this lesson teaches you. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
What you should know before starting this lesson . . . . . . . . . . . . . . 53
Resources you need to complete this lesson . . . . . . . . . . . . . . . . . . . 53
How long should it take?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

About Mari exports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Steps for exporting and importing . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Open your project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Export a channel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Import a channel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Where do you go from here?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Mari 1.4v2The Foundry



PREFACE

Mari is a creative texture-painting tool that can handle extremely complex 
or texture heavy projects. It was developed at Weta Digital and has been 
used on films such as District 9, The Day the Earth Stood Still, The Lovely 
Bones and Avatar.

The name Mari comes from the Swahili 'Maridadi', meaning 'beautiful' and 
carrying connotations of 'usefulness'.

About this manual This manual provides you with the basic information you need to start 
painting with Mari.

The first part of the manual, Installation and Licensing describes how to 
install, license, and launch Mari.

The rest of the manual consists of five tutorials which teach you the basics 
of creating a Mari project and painting textures. The tutorials provide a 
series of comprehensive walk-throughs, complete with geometries and 
associated textures. As you follow the steps in these tutorials, you'll gain a 
good feel for Mari's user interface and workflow. This, in turn, will provide a 
good working knowledge for creating more complex production projects.

For more detailed information on Mari and its functions, see the 
accompanying Mari User Guide and Mari Reference Guide.

Contact customer 
support

Should questions arise that this manual fails to address, you can contact 
Customer Support directly via e-mail at support@thefoundry.co.uk or via 
telephone to our London office on +44 (0)20 7968 6828 or to our Los 
Angeles office on (310) 399 4555 during office hours.



INSTALLATION AND LICENSING

Steps for running 
Mari

To run Mari, follow these steps:

1. Check the System requirements

2. Install Mari

3. Launch Mari

4. License Mari

System 
requirements

System requirements

• Quad-core processor 

• Windows 7 64-bit or Linux 64-bit operating system (Fedora 12 or Red 
Hat Enterprise Linux 5.4)

• 250GB disk space available for caching and temporary files (or a 
minimum of 50GB if you're working on a small project)

• 4GB RAM

• display with 1680 x 1050 pixel resolution

• an NVIDIA graphics card with at least 1GB of RAM and OpenGL 3.0 
support (see Recommended graphics cards below)

Supported graphics cards

• NVIDIA GeForce GTX 480*

• NVIDIA GeForce GTX 580*

• NVIDIA Quadro FX 3800

• NVIDIA Quadro FX 3800M

• NVIDIA Quadro FX 4800

• NVIDIA Quadro FX 5800

• NVIDIA Quadro (Fermi Series) 600*

• NVIDIA Quadro (Fermi Series) 4000*

• NVIDIA Quadro (Fermi Series) 5000*

• NVIDIA Quadro (Fermi Series) 6000*

Please download and install the latest graphics driver for your card from 
the NVIDIA website.

Note *The displacement preview feature in Mari is currently only supported by 
these cards.
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Install Mari 
Install Mari Mari 1.4 is available to download from our web site at 
www.thefoundry.co.uk/mari. The downloads are in a compressed format 
(.run or .exe).

On Linux 1. Download the .run installation file from our web site at www.the-
foundry.co.uk/mari.

2. Extract Mari from the .run archive with the following terminal command, 
replacing [version number] with the current version: 

sudo ./Mari[version number]-linux-x86-release-64.run

The installer displays the End User Licensing Agreement (EULA) and 
prompts you to accept it.

3. If you agree with the EULA, enter y and press Return to accept the 
EULA. (If you don’t agree with the EULA and press n instead, the 
installation is cancelled.)

By default, Mari is installed in an appropriately named folder in the cur-
rent working directory.

4. That's it! Proceed to Launch Mari.

Tip You can also use the following options after the terminal command when 
installing Mari:

• --info

This lets you see what the default installation directory is.

• -- target MyMariDirectory

This lets you specify a different directory to install Mari to (in this case, 
MyMariDirectory).

• --accept-eula

This lets you automate the installation so that you are not prompted to 
accept the EULA. Note that if you use this option, you agree to the terms 
of the EULA. To see the EULA, please refer to Appendix C in the Mari 
User Guide.

• -- help

This lets you see additional help and installer options.

Here’s an example of the syntax using the --accept-eula option:
sudo ./Mari[version number]-linux-x86-release-64.run --accept-eula

Note If you leave out sudo from the terminal command, you need to ensure that 
you have sufficient permissions to install Mari under your current working 
directory or selected target directory. 
Mari 1.4v2The Foundry
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Launch Mari 
After the Mari application files have been installed, the installer also runs a 
post-installation script that creates the following directory:

/usr/local/foundry/RLM

If you don’t have sufficient permissions on the /usr/local folder for this 
directory to be created, the post-installation script prompts you for your 
sudo password as necessary.

On Windows 1. Download the .exe installation file from our web site at www.the-
foundry.co.uk/mari.

2. Double-click on the installation file to start the installation. Follow the 
on-screen instructions. By default, Mari is installed to 
drive letter:\Program Files\Mari [version number].

3. That's it! Proceed to Launch Mari.

Launch Mari

On Linux 1. Open a terminal. 

2. Navigate to the directory you installed Mari to. 

3. Enter ./mari.

4. If you haven’t installed a license for Mari, you need to License Mari. 
Once you’ve done so, click Launch in the Mari Licensing dialog.

Mari checks for Supported graphics cards, and if an unsupported graph-
ics card configuration is detected, a dialog appears warning you about 
it. Depending on the configuration detected, you have the option to 
Quit, Ignore or Ignore Permanently. Note that if you ignore the warning 
and run Mari anyway, you may experience instability or performance 
issues. If a supported graphics card configuration is detected, Mari will 
run as normal.

5. If you are launching Mari for the first time, you are prompted to choose 
a directory for its cache files. In the Please Pick Cache Directory dialog, 
navigate to the directory you want to use and click Choose.

Note that the cache directory should be: 

• empty

• local to the machine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)
Mari 1.4v2The Foundry
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Launch Mari 
• a directory that the user has read and write permissions to.

The Mari graphical interface appears.

Note If the MARI_CACHE environment variable has been set, its value is used to 
determine the location of the cache files. In this case, Mari does not prompt 
you to choose the cache directory. For more information on environment 
variables that Mari understands, please refer to the Mari User Guide.

Tip You can also launch Mari in verbose mode by using the following command:

./mari --verbose

This way, Mari provides a running log of each action that it performs. You 
can see this log in a terminal window.

On Windows 1. Click Start > All Programs > The Foundry > Mari 1.4v2 > Mari 1.4v2.

2. If you haven’t installed a license for Mari, you need to License Mari. 
Once you’ve done so, click Launch in the Mari Licensing dialog.

Mari checks for Supported graphics cards, and if an unsupported graph-
ics card configuration is detected, a dialog appears warning you about 
it. Depending on the configuration detected, you have the option to 
Quit, Ignore or Ignore Permanently. Note that if you ignore the warning 
and run Mari anyway, you may experience instability or performance 
issues. If a supported graphics card configuration is detected, Mari will 
run as normal.

3. If you are launching Mari for the first time, you are prompted to choose 
a directory for its cache files. In the Please Pick Cache Directory dialog, 
navigate to the directory you want to use and click Choose.

Note that the cache directory should be: 

• empty

• local to the machine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)

• a directory that the user has read and write permissions to.

The Mari graphical interface appears.

Note If the MARI_CACHE environment variable has been set, its value is used to 
determine the location of the cache files. In this case, Mari does not prompt 
you to choose the cache directory. For more information on environment 
variables that Mari understands, please refer to the Mari User Guide.
Mari 1.4v2The Foundry
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License Mari 
Tip You can also launch Mari in verbose mode by selecting Start > All Programs 
> Mari 1.4v2 > Mari 1.4v2 (Verbose Output). This way, Mari provides a 
running log of each action that it performs. You can see this log in a 
command line window.

License Mari

About licenses If you simply want to try out Mari, you can obtain a trial license, which 
allows you to run Mari for free for 15 days. See Install the license on 
page 12.

To use Mari after this trial period, you need either a valid activation key or 
a floating license and server running the Foundry Licensing Tools (FLT):

• Activation Keys—These can be used to easily install and activate node 
locked (also known as uncounted) licenses. Node locked licenses allow 
you to use Mari on a single machine. This license will not work on a 
different machine and if you need it to, you’ll have to transfer your 
license. Node locked licenses do not require additional licensing software 
to be installed. See Licensing Mari on a single machine for more 
information.

• Floating Licenses—also known as counted licenses, enable one of our 
products to work on any networked client machine. The floating license 
should be put on the server and is locked to a unique number on that 
server. Floating licenses on a server require additional software to be 
installed. This software manages those licenses on the server, giving 
licenses out to client stations that want them. The software you need to 
manage these licenses is called the Foundry License Tools (FLT) which 
can be freely downloaded from our web site. Floating licenses often 
declare a port number on the server line and a port number on the 
vendor line. See Licensing Mari over a network for more information.

The instructions below run through both licensing methods and you can find 
a more detailed description in the Foundry Licensing Tools User Guide 
available on our website: 
http://www.thefoundry.co.uk/support/licensing/tools/ 
Mari 1.4v2The Foundry

http://www.thefoundry.co.uk/support/licensing/tools/


INSTALLATION AND LICENSING 12
Licensing Mari on a single machine 
Licensing Mari on a 
single machine

Obtain an activation 
key

You can purchase activation keys over the Internet by clicking Purchase 
License in the Mari licensing dialog that displays when you launch Mari 
without a license, or by contacting The Foundry Sales Department at 
sales@thefoundry.co.uk.

Install the license You are prompted to enter your activation key when you start Mari without 
a license. Mari skips this step if you’ve already activated the application.

Select an activation option from the Mari Licensing dialog:

• Purchase License—click to open a web browser directly to The Foundry 
website to purchase an activation key.

• Activate Key or Use Server—click to enter a previously obtained 
activation key. When you enter the activation key, Mari automatically 
obtains a license from the web and installs it on your machine. You’re 
good to go.

• Obtain Trial License—click to automatically install a trial license valid for 
15 days. Whenever you then launch Mari, the Mari Licensing dialog 
displays how many days remain before you trial license expires. Note 
that you can only obtain a trial license for a major Mari release once on 
each machine (for example, if you had a trial license for Mari 1.1v1, you 
can’t get another one for Mari 1.1v2 on the same machine). 

Tip If you later want to change your license (for example, from a node locked 
license to a floating license), you can select Tools > License in Mari to 
display the Mari Licensing dialog. 

Note If you access the Internet through a proxy server and Mari cannot connect 
to the activation server, you may get an error dialog prompting you to 
either:

• Click Use Proxy to enter the proxy server name, port number, username, 
and password. This enables Mari to connect to the activation server and 
obtain a license. Mari then installs the license automatically.

• Click on the web link in the dialog and use the System ID (also known as 
hostid) provided to manually activate and install a license. For more 
information on how to install a license manually, see the Foundry 
Licensing Tools (FLT) User Guide available on our website at
 http://www.thefoundry.co.uk/support/licensing/.
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Licensing Mari over 
a network

Obtain floating 
licenses

Alternatively, you can purchase a floating license key from our website.
To generate you a license key, we need to know your System ID. The System 
ID (sometimes called Host ID or rlmhostid) returns a unique number for your 
computer. We lock our license keys to the System ID. See Install floating 
licenses.

To display your System ID, do any of the following:

• Download the Foundry License Installer for Mari (FLI) utility from 
www.thefoundry.co.uk/licensing and run it. Your System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge from our web 
site and then:

• On Windows, run C:/Program Files/TheFoundry/LicensingTools6.0/
Foundry License Installer.exe

• On Linux, run the following command in a terminal shell: 

/usr/local/foundry/LicensingTools6.0/bin/systemid

Just so you know what a System ID number looks like, here’s an example: 
000ea641d7a1.

Once you have provided us with your System ID number and a license key 
has been generated for you, you will receive the license key in an e-mail or 
Internet download. The license key is contained in a text file called 
foundry.lic. For information on what to do with the foundry.lic file, see 
Install floating licenses below.

Install floating 
licenses

If you requested a floating license from The Foundry, you will receive your 
license key (foundry.lic) in an e-mail or Internet download. You should also 
receive the Foundry License Installer (FLI) application to help you install the 
license key. The FLI is also available to download from 
www.thefoundry.co.uk/licensing. The instructions below tell you what to do 
with these.

1. Make sure you have saved both the license key (foundry.lic) and the 
Foundry License Installer application in the same directory.

2. Run the Foundry License Installer application. The license key should 
automatically appear in the FLI window if the FLI and foundry.lic are in 
the same directory. If they are not, you can either copy and paste the 
contents of the license key or drag and drop the file into the FLI window.

3. Click Install. 
Mari 1.4v2The Foundry
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This checks the license file and, provided that the license is valid, 
installs it into the correct directory.

In order for the floating license to work, you will need to install the 
Foundry Licensing Tools (FLT) on the license server machine. For more 
information on how to install floating licenses, refer to the FLT user 
guide, which you can download from our web site: 
http://www.thefoundry.co.uk/support/licensing/tools/.

4. Once your license server is up and running, launch Mari (if it isn’t 
already running).

5. Click Activate Key or Use Server and enter the server address in the field 
provided. The format for the server name is <port>@<servername>, for 
example, 30001@red.

Note You must perform steps 4 and 5 on each client machine that requires a Mari 
license from the server.

Tip If you later need to display the Mari Licensing dialog again, you can select 
Tools > License in Mari.

Further reading For more information on licensing Mari, displaying the System ID number, 
setting up a floating license server, adding new license keys and managing 
license usage across a network, you should read the Foundry Licensing 
Tools User Guide available on our web site.
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MARI MODEL REQUIREMENTS

Model 
Requirements

Mari requires your model files to be configured in a particular way. 

Models to paint in Mari should not have:

• Overlapping UVs — these can cause paint artifacts, as Mari calculates 
which UV to project the paint onto. If you are sure that the overlaps are 
only on hidden areas (for example, areas on the model that will never 
face camera), you can work with models with overlapping UVs.

• UVs that go over 10 on the U axis — these are ignored.

• Stacked UVs — these cannot be individually selected in UV view. If you 
do have stacked UVs and want to select an individual UV, you need to 
select it in either Ortho or Perspective view first, and then switch back 
to UV view.

Models to paint in Mari cannot have:

• Negative UVs — painting on these is not possible.



ABOUT THE TUTORIALS

The tutorials included in this manual are:

• Tutorial 1: Setting up a Mari Project

• Tutorial 2: Setting the View and Lighting

• Tutorial 3: Painting!

• Tutorial 4: Painting Through and Clone Stamping

• Tutorial 5: Exporting and Importing

The tutorials are self-paced but designed to take roughly 10 to 45 minutes 
each. You might find yourself breezing through one while spending a lot of 
time on another to soak up details you're not quite sure about.

Download sample 
files

Sample files are provided for use with all of the tutorials. You can download 
these files from our web site at www.thefoundry.co.uk/mari and try Mari 
out on them. From the Mari product page, click on the Demo Assets link.

Tutorial format Mari tutorials include the following conventions:

Steps Steps are the specific instructions for you to perform. Steps are organized 
into major actions. For example, all the steps involved in loading the 
geometry when creating a project are grouped on a page with the title 
“Load geometry”. The individual steps are numbered, and describe what you 
should do and what happens in Mari. For example:

1. Next, to bring in the geometry, click .

The Pick Mesh dialog box displays.

Note that the response to each step (what happens when you do it) is in 
italics, and the name of any dialog box that displays as part of that 
response is bold.

Tips Throughout the tutorials, you'll notice tips in italics. These are extra bits of 
information, not necessarily critical to the procedure you're performing but 
worth knowing. For example, here's a tip about following the tutorials 
generally:

http://www.thefoundry.co.uk/mari
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Tutorial format 
Tip When reading through the steps, don't worry too much about memorizing 
details or performing it in Mari. The tutorials are designed for you to 
familiarize yourself with the instructions, and then get some hands-on 
experience with the Sandbox items — referring back to the instructions as 
needed.

Sandbox Throughout the tutorial, you'll also see sandbox items. These are 
instructions for you to have a play, using the sample files set up for the 
tutorial. For example:

Sandbox Try opening an exported .tif file from this project in another program (such 
as Photoshop), changing it in some obvious way, saving it, then re-
importing the changed texture into your Mari project.

Playing is an important part of learning! You can see how the procedures in 
the tutorial might work for you in the real world.
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TUTORIAL 1: SETTING UP A MARI PROJECT

About this lesson

What this lesson 
teaches you

This lesson teaches you what Mari projects are, and how to create them.

What you should know 
before starting this 
lesson

This lesson assumes: 

• a basic knowledge of computers and graphics applications

• that you have read through the Mari Quick Start Guide

• that you know how to start Mari (see Launch Mari).

Resources you need to 
complete this lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample file:

• blacksmith_body.obj 

How long should it 
take? 

Plan on spending about 20 minutes to complete this lesson.

About Mari 
projects

A Mari project holds your work on geometries and associated textures. 
Once you've created a Mari project, you can work on it, save and close — 
and then re-open it to continue working on the same textures later.

Projects also hold other items, such as projectors, shaders, and so on. Mari 
saves some settings at the project level. For instance, each project has:

• a project shelf, to hold brushes, colors, and images for you to use 
specifically in that project

• contents of the various palettes — Image Manager, Brush Editor, and so 
on.

When you first create a project, you can specify its parameters, including:

• the details (such as resolution and color depth) of the initial channel in 
the project

• the range of animation frames to import.
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Open a new project 
Steps for creating 
Mari projects

To create a Mari project, follow these steps:

1. Open a new project

2. Specify project options

3. Load geometry

4. Save your project

Open a new project 1. Start Mari (see Launch Mari). 

The Mari workspace displays, showing the Projects tab. This holds all 
the projects you have been working on.

2. As with most commands in Mari, you can select the New Project option a 
few different ways:

• from the File menu, select New, or

• click  on the toolbar, or 

• click the New button, or 

• press the Ctrl+N shortcut key.

Pick any one of the options above. 

The New Project dialog box displays.

The New Project dialog box has three parts:

• Name — a name for your project. 

• Geometry — the model you'll be painting on.

• Texture — parameters for the textures you'll be creating.

Next we'll specify the name and texture options, and then select the 
geometry.
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Specify project options 
Tip For more on the different options in the New Project dialog box — and 
other dialog boxes illustrated in this tutorial, see the Mari Quick Start and 
Reference Guides.

Specify project 
options

1. For the project Name, type 1-Blacksmith.

2. For the Texture options, right-click on the list of channels and select to 
Create All.

  

Load geometry 1. Next, to bring in the Geometry, click .

The Pick Mesh dialog box displays.

2. Navigate to your tutorial folder, click to highlight blacksmith_body.obj, 
and click Open.
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Load geometry 
3. Click Ok.

Mari conducts a quick “sanity check” on the model to make sure there 
are no obvious problems. If there are any problems, it displays warnings 
or errors. If there are warnings, you can continue. If there are errors, 
you must stop and fix them.

For more information on what kind of models Mari expects, see Mari 
Model Requirements.This model displays with no errors. Mari loads the 
geometry and displays it in your workspace.

Tip Depending on the size and complexity of a model, it can take several 
minutes the first time you load it into a Mari project. Once saved, however, 
the project should open quickly in future.
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Save your project 
Save your project Save your project — again you can do this a few ways:

• from the File menu, select Save, or

• click  on the toolbar, or

• press the shortcut key Ctrl+S.

Mari saves the project into its cache directory. Now, if you click on the 
Projects tab at the top of the screen, you see your new project in the list.

Where do you go 
from here?

At this point, you should have a basic idea of what a Mari project is and how 
to create one. You learned how to:

• name the project

• set texture options

• load geometry

• save the project.

Next, you'll use this project to practice some basics about setting the 
camera and lighting on the geometry in your project, before you begin to 
paint on it. When you're ready, proceed to Tutorial 2: Setting the View and 
Lighting.
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TUTORIAL 2: SETTING THE VIEW AND LIGHTING

About this lesson

What this lesson 
teaches you

This lesson teaches you how to open a Mari project, and then set the view 
and lighting on your geometry (before painting on it).

Setting the view includes:

• rotating

• zooming in or out

• panning

• viewing from six basic directions

• displaying a split view showing a 3D view plus UV patches.

Setting the lighting includes:

• picking “flat”, “basic”, or “full” lighting

• moving lights around and adjusting their properties.

What you should know 
before starting this 
lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read through the Mari Quick Start Guide

• that you know how to start Mari (see Launch Mari)

• that you have completed Tutorial 1: Setting up a Mari Project.

Resources you need to 
complete this lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample file:

• 1-Blacksmith — the Mari project file you created in Tutorial 1.

How long should it 
take?

Plan on spending about 25 minutes to complete this lesson.
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About Mari view and lighting 
About Mari view 
and lighting

The view in Mari is a view on the object you are painting. By default, Mari 
has four types of view:

• Uv — this gives you a “flat” view of the patches in the model.

• Perspective — this show the model as a whole in 3D space, through a 
perspective camera. 

• Ortho — this shows the model as a whole in 3D space, through an 
orthographic camera.

• Ortho/Uv — this is a split screen, showing both the Uv patches and the 
orthographic view.

You can move each view separately. 

Tip You can also use the , , and  toolbar buttons or the F10, F11, 

and F12 keyboard shortcuts to activate a particular view on any tab.

Within the views, you can:

• Spin or rotate the model (3D views only). Spinning turns the model on 
one axis, while rotating lets you turn the model in all three axes. Think of 
spinning as like turning the model on a turntable, while rotate is turning 
it around in midair. 

• Pan to move the view across the model. 

• Zoom in or out. 

Uv View  Ortho View

Ortho/Uv View
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Open your project 
• Focus on a selected patch. 

You separately configure the lighting on the object, by choosing pre- set 
settings for “flat”, “basic”, or “full”, or specifying fine details such as 
shading parameters and separate lighting for each of the four configurable 
lights.

Steps for setting the 
camera and lighting

To set the camera and lighting, follow these steps:

1. Open your project

2. Adjust the view

3. Adjust the lighting

Open your project 1. Start Mari (see Launch Mari).

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.
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Adjust the view 
Adjust the view To adjust the view on your project, you can zoom, pan, rotate, choose one 
of six pre-set views, display your model and patches in a split screen, or use 
perspective and orthographic views.

1. To zoom out and in, hold down the Alt key, right-click and drag the cur-
sor to the left and right.

2. To pan, hold down the Alt key and middle-click (or hold Alt and Shift and 
left-click and drag).

3. To rotate, hold down the Alt key and left-click and drag.

Tip • You can also “spin” around a fixed point by pressing Ctrl+R, left-clicking, 
and dragging.

• When you rotate or spin, the pivot point is located in the center of the 
current view.
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Adjust the view 
4. To view from six basic preset angles (camera “left”, “right”, “top”, 
“bottom”, “front”, and “rear”), press 1, 2, 3, 4, 5, or 6, or select the 
angle from the Camera menu.

5. To see a flat view of the UV patches on the model, click the Uv tab.
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Adjust the view 
6. To see a split screen showing both the Ortho and Uv views, click the 
Ortho/Uv 
tab.

7. To see a perspective view of your model, click the Perspective tab (or 
press F11).

In the Perspective view, you can alter your model’s appearance in the 
viewer by entering Near, Far, and FoV values in the Canvas toolbar. See 
chapter 2 in the Mari User Guide: Set the perspective camera details for 
more information.
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Adjust the view 
8. To see an orthographic view of your model, click the Ortho tab (or press 
F10). This is the default view mode, that is, the view you see when you 
start Mari.

Note The model is in the same position in steps 7 and 8; only the view mode has 
changed. Notice that the model’s arms appear closer to the body due to the 
application of perspective.

Tip You can paint in any of the views. 

9. To switch the view to display all selected patches, press A.

If you don't have any patches selected, the view focuses on the model as 
a whole (changing to show the whole model).

Tip If you find that the view starts cutting through the front clipping plane, try 
pressing A.

10.To center the view at a particular place, move the cursor there and press 
F.

At the current size and angle, the view changes to center on the 
selected point.

Tip Moving the view bakes the current paint if Bake Behavior is set to 
AutoBakeAndClear. You can set this on the Projection palette, under 
Projection (if you can't see the Projection palette, select View > Palettes > 
Projection to display it).

Sandbox • Play around with zooming, panning, and rotating the camera. 

• Try changing between Ortho and Perspective modes. Notice that objects 
closer to the camera distort far more than objects further away?
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Adjust the lighting 
Adjust the lighting Mari comes with three lighting presets: flat, basic, or full. In basic and full 
modes, you can move the lights around the model.

1. To change the lighting:

• from the Shading menu, select Flat, Basic, or Full, or

• click , , or  on the toolbar.

2. Notice the four lights in the viewport (you may need to select the Pan 

Object tool  to see them).

By default, the lights appear as gray spheres .

3. To move a light around, select the Pan Object tool  (if you didn't 

already). Click on a light and drag it around the viewport.

As you move the light, you can see the effect on the model.

4. You can also make fine adjustments to lighting using the Lights palette. 
If it's already open, click the Lights tab to give it focus; or if it's closed, 
right-click in the toolbar area on top of the Mari workspace and select 
Lights to open it.
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Adjust the lighting 
The Lights palette displays details of four lights, which you can enable 
or disable, and customize by adjusting their Color and Fixed To informa-
tion — for details, see Chapter 2, “Customizing the view” in the Mari 
User Guide.

Tip • Lighting can be relative to the Scene or a Camera:

• Scene (default) — the light is fixed to the model, for example if a 
light is set at the model's back, it will always point at the model's 
back, no matter how you move the view.

• Camera — the light is fixed to a camera view, for example you can 
have a light always shining from above the camera, allowing you to 
move the model around and cast light on different areas.

• Mari saves custom lighting with the project. If you need the same lights 
in another project, you will need to set them up separately.

Sandbox Experiment with the different options for lighting.
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Where do you go from here? 
Where do you go 
from here?

At this point, you should have a basic idea of the different options for 
adjusting the view and lighting on your model. You learned how to:

• zoom, pan, and rotate

• choose one of six preset angles

• toggle split view

• change to flat, basic, or full lighting

• move and configure lights.

Now that you know how to create a project, load geometry, and adjust the 
position of the view and lighting, you can (finally) begin to paint! When 
you're ready, proceed to Tutorial 3: Painting!.
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About this lesson 

What this lesson 
teaches you

This lesson teaches you the basic steps to painting on a model in Mari. This 
includes:

• selecting a brush

• selecting a color

• painting with that brush and color.

What you should know 
before starting this 
lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read through the Mari Quick Start Guide

• that you know how to start Mari (see Launch Mari)

• that you have completed Tutorial 1: Setting up a Mari Project and 
Tutorial 2: Setting the View and Lighting.

Resources you need to 
complete this lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample file:

• 1-Blacksmith — the Mari project file you created in Tutorial 1 and 
configured in Tutorial 2.

How long should it 
take? 

Plan on spending about 25 minutes to complete this lesson.
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About painting in Mari 
About painting in 
Mari

Painting in Mari is similar to painting in other standard paint programs — 
you can choose and configure both brushes and colors, and then use them 
to paint an object. In Mari, you configure brushes through the Brush Editor 
and colors through the Color Palette. You also have the option of saving 
colors and brushes to your Shelf for easy access. The Mari Shelf comes with 
lots of presets, as well as any items you have created or customized for 
yourself (and saved there).

After you paint (also as with other programs), in Mari you need to bake the 
paint buffer into the object. Mari includes various ways of baking onto 
selected patches, including an Autobake option that bakes by default every 
time you move the camera.

Steps for painting in 
Mari

To paint in Mari, follow these steps:

1. Open your project

2. Open the Colors and Shelf palettes

3. Select a color

4. Select a brush

5. Paint!

6. Bake your painting

Open your project 1. Start Mari (see Launch Mari). 

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.

Open the Colors 
and Shelf palettes

Basic painting on your model involves selecting a brush, selecting a color, 
and using them to paint. In the steps below, you'll select a color from the 
Colors palette and a brush from your Shelf. To begin, let's open and arrange 
those palettes.

Tip By default, the Colors and Shelf palettes are already open when you start 
Mari (but follow the instructions below to see how to open and close 
palettes).

1. To open the Colors palette:

• from the View menu, select Palettes > Colors, or
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Open the Colors and Shelf palettes 
• right-click in the toolbar area and select Colors from the popup menu.

The Colors palette displays.
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Select a color 
2. To open the Shelf palette:

• from the View menu, select Palettes > Shelf, or

• right-click in the toolbar area and select Shelf from the popup menu.

The Shelf palette displays.

As described in the Mari Quick Start Guide, the shelf can hold your cus-
tomized sets of colors and brushes — but when you first start Mari, the 
shelf will be empty.

Sandbox The Mari Quick Start Guide outlines the different options for arranging 
palettes. Take a few minutes to experiment with docking, undocking, sizing, 
moving, collapsing, and stacking palettes (including the Colors palette and 
Shelf). Over time, you'll find a configuration that works best for you. And 
when you exit Mari, it will remember that configuration for the next time 
you re-start the program.

Select a color 1. You can select a color from the Colors palette a few different ways:

• click in the color field
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Select a color 
• click to select the H, S, or V next to the vertical sliders (to the right of 
the color field), then click and drag the sliders up or down to select 
color and alpha

• drag the horizontal sliders left or right, or type specific values in the 
boxes, to specify:

RGB( )or HSV( ),and Alpha( )

The selected color displays in the Foreground swatch (and in the swatch 
to the right of the vertical sliders).

2. When the color you want is selected in the Colors palette, drag the 
swatch to the Shelf.

You don't have to drag the color to the shelf to use it, but it's useful for 
storing colors you use regularly.
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Select a color 
Sandbox Play around with all the different options for selecting colors. See if you can 
get these:

Tip If you hover the mouse over a swatch, it displays RGB, HSV, and Alpha 
values:
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Select a brush 
Select a brush 1. To select a brush, open the Brush Editor palette:

• from the View menu, select Palettes > Brush Editor, or

• right-click in the toolbar area and select Brush Editor from the popup 
menu.

The Brush Editor palette displays.

The Brush Editor has three tabs:

• Properties — configurable properties of the selected brush (see the 
Mari Reference Guide for details)

• Shelves — the same shelves that appear in your Shelf palette

• Presets — an array of predefined brushes that come with Mari.
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Select a brush 
2. Click the Presets tab. 

Three tabs display along the top for different sets of predefined 
brushes.

Tip At the bottom of the Brush Editor is a scratch area for you to test out the 
selected brush.

3. Click a brush to select it. 

Tip You can press N to swap back to the last brush tip you used. This lets you 
quickly swap back and forth between two brush tips.

Sandbox Browse through the different preset brushes that are available. Try them in 
the scratch area. Try changing some of the properties on the Properties tab.

Tip You can also customize brushes from the Brush Editor, and save them to the 
Shelf. This is covered in the Mari User Guide, but basically involves:

• selecting a preset brush from the Presets tab

• custom-configuring that brush by selecting options on the Properties tab

• saving it by clicking the  button on the Shelves tab.
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Paint! 
Paint! 1. When you have selected a color and a brush (from the Colors palette, 
Brush Editor, and/or Shelf), you can use them to paint on the model. 
First select the paint tool:

• click  on the toolbar or

• press P.

2. Then paint!

Tip • You can undo and redo any action by pressing Ctrl+Z and Ctrl+Y, or 

clicking  and  on the Project toolbar, or selecting Undo and 

Redo from the Edit menu.

• And, you can undo or redo multiple actions at once, by clicking on a 
specific action in the History View palette (from the View menu, select 
Palettes > History View).

The History View palette lists all actions you've performed since opening 
the project. There is no limit on the size of the action history, but it 
clears when you close the project.
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Bake your painting 
Redoing an action in Mari only reverses a previously undone action. You 
cannot use the Redo command in Mari to repeat a command — it's 
reversing an Undo (not a “do that again”).

Bake your painting 1. As with other paint programs, what you paint stays in a paint buffer 
until you “bake” it onto the model. To bake in Mari, make sure all 
patches with unbaked painting are selected, and then:

• from the Painting menu, select Bake, or 

• click  on the status bar, or 

• press B.

Tip The Projection palette also includes a Bake Behavior option, which by 
default (AutoBakeAndClear), automatically bakes every time you adjust the 
view.

2. When you exit Mari, do not save the project. (We'll start the next lesson 
with the unpainted blacksmith you imported in Tutorial 1...)

Where do you go 
from here?

This lesson covered the most basic options for painting in Mari:

• selecting a color in various ways, and dragging it to the Shelf

• selecting a brush from the Brush Editor

• painting on the model and baking.

The next tutorial, Tutorial 4: Painting Through and Clone Stamping, covers 
two main options for using images to create textures in Mari.
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About this lesson

What this lesson 
teaches you

This lesson introduces using images to create textures in Mari. This 
includes:

• “painting through” an image onto your model

• “clone stamping” part of an image onto your model.

What you should know 
before starting this 
lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read through the Mari Quick Start Guide

• that you know how to start Mari (see Launch Mari)

• that you have completed Tutorial 1: Setting up a Mari Project, Tutorial 2: 
Setting the View and Lighting, and Tutorial 3: Painting!

Resources you need to 
complete this lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample files:

• 1-Blacksmith — the Mari project file you created in Tutorial 1 and used 
in Tutorial 2 and Tutorial 3

• Tattoo.png — an image of a tattoo, in your Mari tutorial directory.

How long should it 
take?

Plan on spending about 25 minutes to complete this lesson.
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About painting from images in Mari 
About painting 
from images in Mari

Like with other paint programs, Mari lets you superimpose image files onto 
the surface of an object. To manage image files, Mari includes the Image 
Manager palette. To paint with images you've loaded into the Image 
Manager palette, Mari has two main tools: Paint through and Clone stamp:

• The Paint through tool ( ) lets you position an image over an object, 

and then as you paint, copy from the image directly onto what's under 
the brush.

• The Clone stamp tool ( ) lets you position an image alongside an 

object, with a source point on the image relative to where the brush is on 
the object. Then as you paint, the source point on the image moves in 
sync with the brush on the object, and Mari copies from the image onto 
the corresponding spot under the brush on the object. (You can also 
clone stamp from painting already on an object, in the paint buffer, or in 
another channel.)

Steps for painting 
through and clone 
stamping

To paint through and clone stamp in Mari, follow these steps:

1. Open your project

2. Load an image

3. Paint through

4. Clone stamp

Open your project 1. Start Mari (see Launch Mari). 

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.
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Load an image For both painting through and clone stamping, we'll use an image of a 
tattoo that looks like this:

We'll start by loading that image in Mari's Image Manager palette.

1. To open the Image Manager:

• click the Image Manager tab if it is already open but hidden (as in the 
default Mari layout), or

• from the View menu, select Palettes > Image Manager, or

• right-click in the toolbar area and select Image Manager from the 
popup menu.

The Image Manager palette displays.
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Load an image 
2. To load an image, click .

The Open an Image dialog box displays.

3. Navigate to your tutorial folder, and select Tattoo.png.

That image displays in the Image Manager.
Mari 1.4v2The Foundry



TUTORIAL 4: PAINTING THROUGH AND CLONE STAMPING 47
Paint through 
Paint through Painting through an image basically involves:

• selecting the Paint Through tool

• dragging an image onto the canvas

• painting. 

1. Select the Paint Through tool:

• click  on the toolbar or

• press U.

2. Drag the image from the Image Manager and drop it onto the model.

3. Move and resize the image:

• To resize the image, hold down Ctrl+Shift, click and drag.

• To move the image around the canvas, hold down Shift, click and drag.

• To rotate the image, hold down Ctrl, click and drag.
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Paint through 
Tip The Tool Properties palette includes many options for manipulating paint-
through images.

You can also double-click the image in the Image Manager, and crop a 
smaller portion to use for painting through and clone stamping (see the 
Mari Quick Start Guide).
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Paint through 
Sandbox Try sizing, moving and rotating the image. See if you can get it to look like 
this:

4. Paint through the image onto the model (hold down the left mouse 
button and move, as you do in any standard paint program).

5. When you're done painting through, press P to see just the painted-on 
object.
Mari 1.4v2The Foundry



TUTORIAL 4: PAINTING THROUGH AND CLONE STAMPING 50
Clone stamp 
Tip • To hide the overlying image, press the ? (question mark) key.

• To paint the whole image onto the model in one step, press the ' 
(apostrophe) key.

• To repeat the source image (so you can paint past the edges and have 
the source image repeat), press the ; (semicolon) key.

Clone stamp Clone stamping is like painting through, but the image does not have to sit 
directly on top of the model.

1. First, clear the painted-through textures:

• from the Painting menu, select Clear Painting, or

• click  on the toolbar.

This removes any un-baked painting on the model. In this case, the 
model re-displays as imported.

2. Select the Clone Stamp tool: click  on the toolbar. 

3. Drag the image from the Image Manager and drop it onto the canvas.

The image displays in a separate window.

4. Re-size and position the image window alongside your model. To scale 
the image within the window, hold down Alt, right-click and drag. To pan 
the image, hold down Alt, left-click and drag.

5. To select the source point for cloning on the image, press Ctrl and click.

Once you start painting, a magenta + displays the source point on the 
image.
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Clone stamp 
Tip You can also clone stamp from existing textures — painting on the surface 
of the object, in the paint buffer, or painted in another channel. To select a 
clone source, use the Source menu in the Project toolbar and select from the 
origins available.

6. Once you've selected the source, then paint. The cursor will move on the 
image in sync with the cursor on the model as it clone stamps from the 
image onto the model.

Sandbox Change the view (as covered in Tutorial 2: Setting the View and Lighting), 
and try both painting through and clone stamping the image onto another 
side of the object. Do you like one method of using images to paint more 
than the other?
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Where do you go 
from here?

This lesson covered the two main options for painting images onto a model:

• dragging an image and positioning it on top of an object, then Painting 
through the image onto the surface of the object

• dragging an image and positioning it on the canvas next to an object, 
then Clone stamping from a part of the image to the surface of the 
object.

The next tutorial, Tutorial 5: Exporting and Importing, covers procedures 
for saving and re-importing your work.
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About this lesson

What this lesson 
teaches you

This lesson explains how you can export channels you've painted in Mari as 
a set of image files, work on those files in another program, and then re-
import them into your Mari project.

What you should know 
before starting this 
lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read through the Mari Quick Start Guide

• that you know how to start Mari (see Launch Mari)

• that you have completed tutorials 1 through 4 — so you know the basics 
of creating a Mari project, setting up the camera and lighting, and 
painting textures.

Resources you need to 
complete this lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample files:

• 1-Blacksmith — the Mari project file you created in tutorial 1 and used 
in tutorial 2, tutorial 3, and tutorial 4.

How long should it 
take? 

Plan on spending about 25 minutes to complete this lesson.

About Mari exports Mari includes the facility to export the painting in a project to a series of 
image files. You might use this, for example, to modify part of your work in 
an external program (such as Photoshop) and then re-import those 
modifications into the project. Mari lets you select a format and naming 
conventions for the export. Each export contains the painting baked in a 
selected channel, one image file per patch. When you import a series of 
previously exported files, Mari lets you know whether it's a complete set.
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Open your project 
Steps for exporting 
and importing

To export and import Mari painting, follow these steps:

1. Open your project

2. Export a channel

3. Import a channel

Open your project 1. Start Mari (see Launch Mari). 

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.

Export a channel 1. To export the current channel, from the Channels menu, select Export.

This exports the currently selected channel (in this case, Color). To 
export any channel, right-click the channel you want to export in the 
Channels palette, and select Export from the popup menu.

The Export <channel name> Channel dialog box displays (in this case, 
Export color Channel).

2. If necessary, use the two left-hand navigation boxes to navigate to your 
tutorial folder.

3. Note the Template field. Mari will name each image file in the export, 
one per patch, based on this template. The default is 
$CHANNEL.$UDIM.tif.
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Export a channel 
Note also the File Example below it, which displays what a filename will 
look like with that template. In the illustration, it's: color.1001.tif

So each filename will include the following (with examples from the illus-
tration):

• $CHANNEL — the name of the channel you're exporting: Color.

• $UDIM — an incremental number identifying each patch: 1001 (fol-
lowed by 1002, 1003, and so on).

• tif — the extension for the selected file format. You can set the format 
for the exported files by changing this extension. Mari supports stan-
dard image formats (such as TIFF, EXR, PNG, JPG, or TGA).

Tip The formats available to export depend on the color depth of the channel. 
Channels with color of Half or Full can only export to EXR format.

4. Click All.

This exports all patches. To only export the patches that have been 
modified since the project was last exported, select Modified Only.

You may be prompted that the selected directory does not exist, and 
asked whether you want to create the channel. Select to create it.

Tip For a complete explanation of export fields, see the Mari Reference Guide.
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Import a channel 
Import a channel 1. To import a channel (for example if you've tweaked some exported 
image files in another application and now want them back in your tex-
ture):

• from the Channels menu, select Import for the currently selected chan-
nel, or

• right-click on the channel where you want to import the textures (in 
this case, Color) in the Channels palette, and select Import from the 
popup menu.

The Import <channel name> Channel dialog box displays (in this case, 
Import color Channel).

2. Select the path for the imported images, by either:

• typing it in the Path field at the top of the dialog, or

• clicking on it in your directory bookmarks (to the left), or

• browsing to it in the middle pane.

If you are using the middle pane to browse to the directory, you can use 
the buttons above the view to navigate back, forward, up one directory 
level, create a new directory, or switch between icon only and full details 
directory view.

3. Select the texture set to import.

Mari shows all the texture sets available under the selected directory, 
arranged by subdirectory. 

For each texture set, the Import <channel name> Channel dialog box 
includes:

• Full — shows a green bar if the selected image sequence has a full set 
of images for the current model, a yellow bar if the selected image 
sequence has a partial set of images for the current model, or a red 
Mari 1.4v2The Foundry



TUTORIAL 5: EXPORTING AND IMPORTING 57
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bar if the selected image sequence has no images for the current 
model. 

• Images — the name of each image to import, with the udim number 
represented as @ (in this case, color.@.tf).

• Start and End — the first and last UDIM numbers in the image set (in 
this case, 1001 to 1055).

• Count — the number of images in the set (in this case, 50).

4. From the Resize drop-down, select how Mari should act when importing 
a texture at a different resolution to the patch:

• Patches — Mari will resize the patch to match the size of the imported 
image.

• Images — Mari will resize the imported image to match the size of the 
patch.

5. Click the buttons at the bottom of the dialog to import onto either All 
patches in the project, or Selected only.

Mari imports the textures from the selected files. 

Sandbox Experiment with your options for importing textures.

Where do you go 
from here?

This lesson showed you how to:

• export a channel in a Mari project to a series of image files

• import an exported channel, for example after having manipulated the 
exported textures in another program.

Congratulations! You have now completed all modules in the Mari Tutorials. 
To better familiarize yourself with the features you are particularly 
interested in or to get answers to specific problems that arise during 
painting, please refer to the accompanying Mari User Guide and Mari 
Reference Guide.
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